
สุดยอดเทคนิคการรีทัชตัดตอภาพ 
1. ทําหิมะตก 

เปนบทความท่ีท้ิงหางจากบทท่ีแลวไกลโขเลย แรงกระตุนจากสมาชิกทานนึงตองการทํางานใหออกมาแนว 
หิมะตก ท่ัวบานท่ัวเมืองในท่ีๆไมอาจจะเกิดขึ้นไดแตก็เกิดขึ้นแลวสิเนี่ย เกิดไดอยางไร เปนธรรมชาติหรือไม 
ผลท่ีออกมาก็ไดขั้นตอนและรูปสําเร็จท่ีไดลงในหนากระดานขาวไปแลวครับ 
1.ดูรวมๆแลวหรือไมรวมมองเห็นไดงายวาบทความนี้จะไมคอยเหมือนกับบทอ่ืนๆนะครับ (แบบวาขี้เก
รียจม้ัง)ผมไดทําการเซฟไวเองแหละแลวก็เลยเอามาถอยหลังใหทานชมกันนะสิครับ  
-ในเลเยอร BGเม่ือทานปรับแตงแสงเงารูปไดตามตองการแลว ดังรูปนี้ผมไดเพ่ิมความคมชัดลงไปเปนพิเศษ
ครับ 

 
2.ในเลเยอรท่ี1ผมไดใส Filter>Rander>Lighting Effects ปรับตามผมก็ไดหรือตามใจทานก็
ไดหรือไมปรับเลยก็ไดครับ ̂ ^ (แลวแตชอบไง)  
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3.ผมทําเลเยอรใหมเปนเลเยอร2นี้ผมใชBrush เพนทครับเปอรเซนตออน-แก ตามความเหมาะสมครับ คือ
แบบวาอะไรก็แลวแตท่ีตกลงมาจากดานบน ลงมาสูดานลาง ซ่ึงเปนท่ีรองรับไว ท่ีตรงนั้นก็จะเต็มไปดวยขี้ฝุน 
เอยไมใชครับเพราะเรากําลังจะ ทําหิมะตกนี่นา...^^สังเกตุไดวาผมจะไมละเลงตรงในท่ีๆมีการไดสําผัสอยู
ตลอด เชน ถนน ทางเทา เพราะวาพ้ืนท่ีตรงนั้นจะตองมีรถวิ่งอยูไปมา จึงมีหิมะนอยไงครับ ทานจะใชยางลบๆ
ดวยก็ไดเชนกันครับ 

 
 
 
4.ท่ีเลเยอร2เชนเดิมครับรูปดานลางท่ีทานเห็นนี้คําอธิบายจะอยูในขอ4.1ครับ 

 
 
 
4.1.ทานจะเห็นและไดกระทําหนาตางLayer Styleนี้ไดทานจะตอง คลิกตัว f ท่ีดานลางพาเล็ตเลเยอร

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


ครับ ผมปรับ Drop Shadow กับ Outer Glow เทานั้นครับยังไงแลวทานก็ลองปรับตามผมดูก็ได
ครับ ตรงNoise ทานสามรถปรับความฟุงไดตามความพอใจไดครับ 

 
 
 
5ท่ีเลเยอร3 .ขอนี้ดูเผินๆเหมือนไมเห็นมีอะไรเลยเนาะ แตมีครับ ผมเอาเงาตกทอดท่ีอยูดานลางหิมะ(รูปจริง)
ขึ้นมาไวดานบนครับ ปรับOpacityท่ีพาเล็ตใหจางลงครับ  

 
 
 
6.ผมสรางเลเยอร4ใหมโดยกดท่ีดานลางของพาเล็ต Newlayerขางๆถังขยะครับ (ดูขั้นตอนการทําท่ีขอ7-
8-9-10-11) 
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7.วิธีการทําของผมก็คือเปดเลเยอรแลว เทสีขาวลงไปครับ แลวปรับท่ี Filter>Noise>Add Noise 
ปรับประมาณนั้นครับ  

 
 
 
8.ไปท่ีFilter>Blur>Motion Blur ผมปรับประมาณนั้นครับ  
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9.ผมใช Lavels โดยเขาท่ีเมนูบาร Image>Adjustments>Lavels แลวก็ปรับดังรูปแหละ  

 
 
 
10.แลวผมไปตอท่ี Filter>Stylis>Emboss ปรับประมาณนั้นครับ  
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11.แลวผมไปตอท่ี(โหเยอะจังนิ)ผมใชLavelsปรับอีกครั้งครับ ดังรูป  

 
 
 
12.กอนท่ีจะเกิดเลเยอรท่ี5ไดนั้นผมไชวิธีทีเด็ดของผมครับ(ท่ีบทความเรื่องเทคนิคพิเศษครับ)ใหทานกด
Ctrl+Alt+3ครับจะไดดังรูปครับ 

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
 
 
13.ใหทานกดCtrl+jจากเลเยอร4ก็จะกลายเปนเลเยอร5เลยครับ ดังในรูป ในขั้นตอนนี้ทานสามารถใส
ฟลเตอรเพ่ือตองการใหความนุมนวลของเกล็ดหิมะ(หรือเม็ดฝน)โดยไปท่ี Filter>Blur>Gaussian 
Blur 

 
 
 
14.ท่ีเลเยอร4นั้นก็หมดความหมายไมไดใชเลยครับทานจะลบท้ิงหรือเก็บไวเลนอะไรตอก็ไดนะ^^ 
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รูปดานลางนี้ผมไดรวมเลเยอรโดยคลิกท่ีลูกศรมุมบนขวามือท่ีพาเล็ตเลเยอรแลวเลือก Flatten Imge เสร็จ
แลวปรับสีสันแสงเงาอีกทีครับจริงๆแลวผมไมคอยไดเลนแนวนี้เทาไหร บางทีเพ่ือนๆนองเขามารวมสนุก
เหมือนเกิดจุดประกายขึ้นมาสิ  

 
บทความนี้อาจจะแตกตางไปจากบทอ่ืนๆ ยังไงแลวหากถูกใจก็ของจงปรบมือดังๆใหถึงบานผมเลยเนาะ^^หาก
ทานชอบแนวใหน หากผมทําไดก็จะทําใหไดดั่งใจก็แลวกันครับ 
masterkae 
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2. การลงสีใหกับภาพลายเสน ขาว-ดํา 
1. การลงสีภาพใน Photoshop เปนอีกหนึ่งกรรมวิธีท่ีตองอาศัยทักษะความสามารถ 

และประสบการณมากพอสมควร สําหรับทานท่ีมีพ้ืนฐานการวาดรูปอยูแลวอยางอาจารยแกละแหงเว็บนี ้
หรือคุณลุงสรณ (ท่ีผมขโมยรูปมาสาธิต)ก็อาจจะอมยิ้มเพราะเปนของหวานหมูสําหรับทาน  

แตกับคนท่ัวไปอยางเชนกระผมเปนตน มันก็เหมือนยาขมหมอใหญ ท่ีตองอาศัยระยะเวลาฝกฝนอีกยาวนาน 
แตถาเปนการลงสีใหกับภาพรายเสนขาวดํา ผมพอมีเคล็ดลับวิชามารท่ีจะชวยใหทานสรางงานไดอยางไม

นอยหนาทานจอมยุทธเหลานี ้เทคนิคนี้ผมเก็บงําไวนานพอควร วันนี้เอามาเผยก็หมายความวาหมดทางหากิน
กับมันอีกแลว 

 
 

2. เริ่มจากการ Copy เลเยอรภาพขาว-ดํา ไวขางบน เปล่ียนเปนโหมด Multiply 
เสร็จแลวสรางเลเยอรเปลาขึ้นอีก1เลเยอรแทรกไวระหวางเลเยอรท้ัง2 
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3. ลงมือลงสีตามชอบบนเลเยอรท่ี2 ไมตองกลัววาจะเลอะลายเสนภาพบน เพราะภาพบนถูกวิชามาร 
เปล่ียนเปนโหมด Multiplyแลว มันจึงทําหนาท่ีคลายแผนใสทับไวอีกช้ันหนึ่ง ระบายใหตายยังไงก็ไมมีวัน

เลอะ  
ทําใหประหยัดขั้นตอนท่ีตองสรางซีเลคช่ันแตละสวนเหมือนท่ีทํากับภาพอ่ืน  ๆ

 
 

4.สวนในเรื่องแสงเงาก็งายมากไมตองเสียเวลาไปเลือกโทนสีออนแกใหยุงยาก ใหทานใชแค 
Dodge Tool กับ Burn Tool ปรับเปอรเซ็นตใหต่ําๆเขาไว ไลไปตามสวนท่ีจะสรางแสงและเงาจน

ท่ัวท้ังภาพ 
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5. ขั้นตอนสุดทายเปนขั้นตอนเก็บรายละเอียด ถาเห็นวาเม็ดในภาพรายเสน เม็ดหยาบเกินไป 
ดูไมสวยงามก็ใหใช Blur Tool ไลไปตามพ้ืนผิวของเลเยอรบน แตตองระวังอยาใหไปถูกเสนขอบภาพนะ

ครับ  
เพราะจะทําใหรายละเอียดภาพเสียหาย 

หลังจากนี้ทานจะหาแบ็คกราวนอะไรสวยๆมาใส เพ่ือใหภาพสมบูรณขึ้น ก็ตามสะดวกครับ  
แลวพบกันใหมเม่ือชาติตองการนะครับ 
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3. หนาเนียน ขาว ขจัดสิวฝา 
ในบทนี้จะเปนการรวมขั้นตอนตางๆท่ีผมไดแนะนําไปบางแลว ผมก็เลยจับเอามารวมๆกันเปน1ช้ินงานกันเลย
ครับ อีกอยางผมก็ไดขอคิดจากทานนึงท่ีเขียนในกระดานขาวไว ผมอยากใหเปน1ช้ินงานท่ีสมบูรณ(วาง้ันเลย
ครับ) คุณนูนาสมาชิกท่ีขอมาวาอยากทําการรีทัชรูปใหหนาเนียน ใหหนาขาว และเก็บรายละเอียดเอาสิวเอาฝา
ออกไป 
1.รูปตนแบบท่ีผมไดจากคุณนูนา นํามาใหเปนแบบแนะนํากันครับผม  

 
 
2.วิธีการท่ีผมชอบมากท่ีสุดครับ อาจจะเปนหัวใจของผมเลยก็วาได ใหทานกด Ctrl+Alt+1หรือ2หรือ3ก็
ไดครับ(จะอยูในบทกอนๆท่ีลงไว) 
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3.ขอขยายความวาCtrl+Alt+1หรือ2หรือ3ครับผม ..หากทานกด+1แลวเสนปะใขปลาเนี่ยนะถากินเนื้อ
ท่ีเขาไปในความเขมเกินไปหรือรายละเอียด จะไมมีผลดีเทาท่ีควรผมเลยจึงตองใหทานเลือกเอาดูวา ท่ีรูปของ
ทานนั้นจะใหผลลัพทท่ีตางกันครับ ยกตัวอยางเชนรูปท่ีคุณนูนาเอามาใหผมเนี่ยนะผมอัฟไฟล ไปอยูท่ี
800x1000 pxเทานั้นเองครับ ขนาดนี้จะอยูใงานถายสตูดิโอรูปขนาดเล็กๆเทานั้นเองครับผม แตทวาหาก
ทานจะตองทํางานที่ไฟลใหญกวานี้ขึ้นไปทานก็ตองปรับคาตางๆใหมากกวาผม ดังท่ีผมจะแนะนําในหัวขอขางนี้
ตอไปครับ  

 
 
4.เม่ือทานทําตามวิธีขางบนนั้นแลวใหทานกดctrl+j ทานจะไดเลเยอรใหมท่ีพาเล็ตเลเยอรครับ คือเลเยอร1( 
ในสวนของแสง ระดับท่ีตองการครับ) 
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5.ท่ีเลเยอร1ใหทานไปท่ี Fillter>Noise>Dust&Scratches ทานก็จะไดหนาตางดังรูปขางลางนี้
ครับ แลวทานก็ปรับแถวลางนั้นคงท่ีไวนะครับ สวนแถวบนทานก็ปรับเอาตามใจชอบก็ได(พอประมาณครับ
ผม)  

 
 
6.ผลท่ีไดตอนนี้แคนี้กอนนะครับผม(เดวจะคมขึ้นครับ) 
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7.ใหทานคลิกเลือก ท่ีเลเยอรBG (ท่ีพาเล็ต Layers)และหยิบเครื่องมือ Healing Brush ผมตั้งคา
ตางๆดังรูปขางลางนี้แหละครับ(ในชองAlignedหากทานเลือก เครืองหมายบวกในรูปจะเดินตามหัวแปรง
เวลาเราคลิกไปอีกท่ีครับ) สังเกตุวาหัวแปรงท่ีผมใชนั้นจะไมใหญมากนะครับ หากหัวแปรงใหญเกินไปอาจทํา
ใหพ้ืนท่ีผิวเนื้อท่ีดีนั้นถูกทําลายไปดวย เม่ือทานตั้งทาตั้งคาตางๆเรียบรอยแลว ใหทานกด Alt ที่แปนคียบอรด
คางเอาไว แลวคลิก1คร้ังตรงบริเวณพ้ืนผิวที่สมสมบูรณ แลวนํามาคลิกลากหรือคลิกครั้งเดียวตรงบริเวณพ้ืนผิว
ท่ีไมตองการออกไปครับ ดังท่ีเห็นในรูปนั้นเครื่องหมายบวก ก็คือท่ีเรา กด Alt ที่แปนคียบอรดคางเอาไว แลว
คลิก1คร้ังตอนเริ่มแรกนั้นแหละครับ ท่ีเห็นเปนรูปวงกลมนั้นก็คือหัวแปรง ท่ีเราเอาตรงเครื่องหมายบวกมา
แทนท่ีไงครับ(งงไมครับเนี่ย)คือแบบวาผมอยากใหทานท่ีเริ่มใหมๆไดอานแลวเขาใจแบบคุณนูนาแหละ เพราะ
บทแรกๆบางทานเริ่มใหมๆแลวบอกวาอานแลวงงเนาะ^^  
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7.1.ในรูปขางลางนี้จะทํางานลัษณะคลายๆกันครับ (ดูรูปใหญแลว รูปท่ีคุณนูนาสงมาใหนี ่ไฟลเล็กไปหนอย
ครับ หากถายท่ีความละเอียดมากหนอย รูปจะไมแตกครับ) 
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8.แลวเราลองมาดูการเพ่ิมความคมชัดในบทนี้ดูกันครับ ใหทานไปท่ีเลเยอร1 และหยิบเครื่องมือ Eraser(
ยางลบ)ผมใชคา Opacity ท่ี40%ครับเพราะมานคือยางลบท่ีผมจะใชลบเหมือนยางลบจริงๆสิครับ ถาหาก
เราใช Opacity100%อันนี้สะอาดเกินความจริงครับ ผมอยากใหทานคอยๆลบออกนะซี (จริงๆแลวควร
จะออนกวานั้นดวยซํ้าไป) ใหทานลบเฉพาะในสวนของรายละเอียดท่ีเปนจุดสําคัญๆก็พอแลวครับ อยาเผลอลบ
เพลินละครับ 

 
 
8.1..สวนสําคัญท่ีผมลบออกจากรูปนี้แหละครับ เอาเปนวาหากทานตองการลบตรงใหนเนี่ย ตรงท่ีลบออกไป
นั้นก็คือรูปเดิมๆเลยแหละ ^^ 

 
 

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
9.เรามาถึงขั้นตอนการเพ่ิมแสงใหกับใบหนาแลวครับ(ท่ีเลเยอร1นะครับ)ใหทานหยิบเครื่องมือดังรูปในกลอง
เครื่องมือดานซายนั้นครับผม แลวทานก็ตั้งคาท่ีออปช่ันบารดานบนตามผมก็แลวกันครับ ท่ีทานเห็นเปนเสน
ปะใขปลานั้น ใหลองใชเครื่องมือตัวนี้คลิกลงบนรูปของทานสิครับ(จิ้มเลยๆ)ครั้งเดียวนะครับอยาเพ่ิงตกใจครับ
ผม มานจะมีเสนเหมือนเชือกเลยใชไหมครับ เรียกวาหากทานขยับเมาสไปท่ีไหนรับรองถายิ่งไปไกลๆแลวละก็
ทานหาทางกลับไมถูกแนเลย(เอาๆง้ันผมใหทานดับเบ้ิลคลิกเลยดีกวาเดี๋ยวจะไปกันใหญ) เขาเรื่องๆกันเอาจริงๆ
แลวนะครับ เม่ือทานใชเครื่องมือ Polygonal Lasso คลิกลงบนรูป1ครั้งแลว ๆทานก็คลิกตอไปท่ีละ
ชวงๆใหไดความโคงเวา( ก็แลวกันเนาะ) ตอนท่ีทานยังไมไดเอาหัวชนหางหรือหางชนหัวเนี่ยนะครับ มานก็ยัง
ไมเปนเสนปะใขปลาใชไมครับ คือวาจะมีอยูสองกรณีครับที่จะมาปะจบกันไดก็คือ 1.หัวชนหาง 2. ดับเบิ้ล
คลิกครับผม หรือผมเพ่ิมใหอีกกรณีนึงก็ดีเพราะแตกอนผมเจอบอยเลย คือแบบวาผมชอบใหไดความโคงมากๆ
ไงผมก็เลย คลิกซะชิดกันเกินไปมานก็เลย กลายเปนดับเบิ้ลไง^^ เอาเปนวา มีวิธีอ่ืนๆอีกครับท่ีจะทําใหออกมา
เหมือนเสนแบบนี้นะครับ แลวผมจะเอามาเพ่ิมใหทีหลังเนาะ คือวาตัวนี้ผมใชบอยมากๆเลย ขอตอทายหัวขอ
หนอย หากทานจะยอนการคลิกเสนปะ ทานก็กดลูกศร คีย Bavkspaceที่แปน(ที่ละคร้ังครับ) หากจะลบ
เสนปะออก ใหทานกด Ctrl+D ครับ หากจะเรียกกลับคืนมาใชอีก ทานก็กด Ctrel+Alt+D ที่แปนคีย
บอรดครับผม 

 
 
 
10.ท่ีรูปดานบน และ ท่ีเลเยอร1นั้นทานสามารถปรับแตงสีสันไดอีกเชนกันครับ ดังรูปขางนี้แหละครับ ออๆ
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อยาลืมรวมเลเยอรดวยนะครับ กด Shift+Ctrl+E ครับผม จากนั้นเลเยอรก็รวมแลวครับ 

 
 
..บทนี้เลนเอาผมหอบเหมือนกันสิเนี่ย ผมมาคิดๆด ูบางทานท่ีเพ่ิงเริ่มใหมๆเนี่ยนะครับ มาอานบทความของผม 
ก็คงจะทําความเขาใจกันลําบากสักหนอยเนาะ เอาไวในบทตอๆไปผมจะอธิบายให(งง)ระเอียดๆแบบนี้อีกครับ
กะผม^^ 
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4. ทําฉากหลัง 
เกือบลืมเลยมีทานนึงขอมา อยากใหชวยจัดฉากแนวท่ีใชกับภาพคน แตผมวาใชไดกับทุกรูปแบบแหละครับ ผม
เลยจัดใหด3ูแบบแระกันเนาะ ก็เชนเคยครับในแนวท่ีผมใชอยูเปนประจําๆก็เห็นจะเปนฉากแบบท่ี3ครับ 
แบบท่ี1.เม่ือทานสรางพ้ืนท่ีเตรียมทําฉากขึ้นมาแลว ใหทานดับเบ้ิลคลิกท่ีเลเยอรbackgrund เลเยอรก็จะ
เปล่ียนเปนLayer 0  ครับ(ตั้งช่ือไวดวยก็ไดนะครับ) 

 
 
รูปขางลางนี้แหละครับ 

 
 
 
แลวทานคลิกเลือกตัว f ในวงกลมสีแดง ใหทานเลือก Gradient Overlayครับผม  

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
 
ทานจะไดหนาตาง Layer Style หมายเลข1 นั้นผมใสเครื่องหมายถูกเขาไวก็เพ่ือจะใหความเขมอยู
ดานบนครับ สวนหมายเลข2 ใชปรับความนุมนวลครับ  

 
 
 
ออกมาหนาตาดังรูปขางลางนี้แหละครับ 
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หากทานจะปรับแตงสี ทานก็คลิกท่ีหมายเลข 1 ครับ แลวเลือก Color Balance ปรับสีตามใจเลยครับ  

 
 
 
สุดทายก็อยาลืมรวมเลเยอรละท่ีหมายเลข 1 ตรงลูกศรคลิกออกมาแลวทานก็เลือกท่ีหมายเลข2นะครับทุกเล
เยอรก็จะรวมกันครับ 

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
 
 
มาดูแบบท่ี 2 กันครับ สรางพ้ืนท่ีและลงสีตามตองการครับ 

 
 
 
ใหทานไปท่ี Filter>Render>Lighting Effects ระบุตามผมหรือตามใจทานก็แลวกันเนาะ 
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โทนสีและน้ําหนักออกมาเปนแบบนี้แหละครับ 

 
 
 
แบบท่ี3.ผมใชรูปท่ีเสร็จจากแบบท่ี2มาใชครับ.ใหทานคลิกเปดเลเยอรขึ้นมาใหมท่ีวงกลมสีแดงครับ ทานก็จะ
ไดเลเยอรใหมครับ. ..ท่ีเลเยอร1ใหทานใชBrushตั้งคาOpacity3-5% Fiow100ระบายทับไปมาใน
สวนท่ีตองการ ดังในรูปผมใชสี4สีนั้นครับ ทานสามารถปรับOpacityท่ีพาเล็ตเลยอรใหออนลงไดและยัง
สามารถใชยางลบๆออกไดอีกดวยเชนกันครับ 
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ขั้นตอนนี้ผมท่ี Image>Adjustments>Auto Levels ครับและผมไดปรับความนุมนวลโดยการ
ไปท่ี Filter>Blur>Gaussian ผลท่ีออกมาดังรูปดานลางนี้แหละครับ  
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..อารมณสีอารมณแสงหรือทุกจังหวะของการใสลงไปในงาน ตางคนตางชอบเนาะ ทานสามารถปรับแตงสีสัน
ไดใหมอีกเชนกันครับ หวังวาทานคงทํามาใหชมกันบางนะครับ อยากดูครับวาไดผลและสีสันท่ีทุกทานชอบ
เปนเชนไรกัน 
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5. ทําภาพนุม 
การทํางานในระบบแนวเวดดิ้งหรือการถายภาพแฟช่ันนั้น ผมพอสรุปเอามาเปนตัวอยางหนึ่งของในแนวผมท่ี
ชอบทํานั่นเองครับ รูปจะลดครวามแข็งกระดางลง 
ตัวอยางท่ีผมนํามาสาธิตนั้น ไฟลจะอยูท่ีประมาณ355px506pxคับผมผมอยากใหทานเปรียบเทียบคาตางๆ
เม่ือทานกําลังทํางานอยูกับอีกไฟลขนาดหนึ่งนะคับ 

 
 
เม่ือทานเปดรูปมาแลว ใหทานไปท่ีimage>duplicate ดังรูปขางลางนี ้

 
 
ทานจะไดรูปใหมครับ 
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ท่ีรูปใหมนี้ใหทานไปท่ีimage>grayscale 

 
 
 
คลิกok 

 
 
 
ท่ีรูปใหมทานจะไดดั่งรูปขางลางนี้คับ 
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ใหทานไปท่ีฟลเตอรGaussian blurปรับแคนิดเดียวครับใหเทาผมนะ 

 
 
ใหทานกลับมาท่ีรูปเดิมครับ(คือรูปตอนเปดทํางานครั้งแรกนะคับ) 
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ทานไปท่ีselect>Load selection ดังรูปขางลางนี ้ 

 
 
 
คลิกokเลยคับผม 

 
 
 
ทานจะไดเสนselectionแบบรูปขางลางนี้คับ สวนรูปขาวดําgrayscaleนั้นทานคลิกออกไดเลยครับ 
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ใหทานกดctrl+jทานจะไดเลเยอรใหมดังรูปขางลางนี ้

 
 
 
ท่ีเลเยอรใหมใหทาน ไปท่ีฟลเตอร Gauss blur ปรับใหเทาผมหรือวาหากทานชอบนุมๆแบบใหนกะตามใจ
ปราถนาเลยคับลองดูเนาะ  
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ความนุมนวลท่ีได(ท่ีผมชอบนะ)ประมาณนี้แหละรูปขางลางเนี้ย ในสวนของลายละเอียดหากทานตองการใหอยู
คงเดิมทานก็ใชยางลบๆออกไดนะครับ ใช%broushนอยๆนะครับ(ท่ีเลเยอร1นะ) 

 
 
เปนอยางไรบางครับ การถายรูปแนวนี้แลวเราเอามาใสขั้นตอนในแนวของผมกอเปนวิธีหนึ่งท่ีชวยทําใหรูปดูมี
อารมรณ ไมแข็งกระดาง ดูแลวสบายตาดีเนาะและในสวนของลายละเอียดท่ีเปนความเขมนั้นไมหายนะคับยัง
อยูครบเลย ทานสามรถนําเอาเทคนิคนี้ไปดัดแปลง ชวยเกี่ยวกับเพ่ิมหรือลดแสงและการใสสีไดอีกดวย อาเกือบ
ลืมทานอยาลืมรวมเลเยอรดวยละคับ 
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6. ภาพเกาเปนใหม 
รูปสีท่ีเปนรูปเกานั้นผมวาทํายากกวารูปขาวดําอีกนะ แตผมก็พอมีวิธีอยูบางท่ีจะฟนรูปใหดูพอไดนะครับ แตยิ่ง
เปนสีเกาดวยและก ็ไมชัดอีกดวยเนี่ยเอาเรื่องเหมือนกันสิ  
ผมตัดรูปตนแบบใหดูแคบลงเพ่ือท่ีทานจะไดเห็นงายขึ้นเนาะ 

 
 
ในขั้นตอนแรกนี ้ผมใชaoto lavels ปรับครับ ไดอยางท่ีทานเหนแหละ เม็ดอะไรๆ ขึ้นเต็มเลยซิ ความเกา
ของกระดาษรูปสีนั้นผมวาไมสูจะดีเทากระดาษรูปขาวดําครับ 
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รูปนี้ผมไปท่ี filter>noise>dust & daubsches เพ่ือลดรอยเม็ดเล็กเม็ดใหญ ของความสกปรกของ
กระดาษ แลวผมไดเก็บรายละเอียด โดยใชbush ประมาณ opacity10-20% flow100 ระบายโดย
ใชหัวภูกันเล็กหนอยท่ีบริเวณ ตา จมูก ปาก ลองแกม คาง ระบายซํ้าๆคอยๆเพ่ิมไมรีบรอนครับ ผมจะจุมสี
บริเวณไกลเคียงเอามาใชนะ 

 
 
ในรูปนี้ผมใช healing bush จุมพ้ืนผิวท่ีสะอาดๆ แลวนําไปแทนท่ี รอยเม็ดตางๆคับผม  

 
 

มาถึงขั้นตอนี้ผมคลิกท่ีรูปออปช่ันบารนี้ครับ  แลวล็อคselectionโดย
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บริเวณท่ีทานเห็นแหละคับ สวนตรงตานั้นผมคลิกท่ีรูปออปช่ันบารนี้ครับ  
แลวล็อคselectionครับเพ่ือการปรับสีแดงหรือชมพูไมใหเขาไปในตานะ เสร็จแลวผมไปท่ี color 
balaance เพ่ิมสีตามความตองการ  

 
 
เม่ือสีไดเขมขึ้นและบางสีเกาไดถูกกดดันใหเพ่ิมขึ้นมาดวย อยางท่ีทานเห็น ผมเลยใช clone stemp โดย

ปรับท่ีออปช่ันบาร เพ่ือท่ีจะเกล่ียใหเกิดความนุมนวล
ขึ้นครับ 
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หลังจากผมไดทํากรพบวนการตางๆเกือบโดยสมบูรณแลว ผมจะเพ่ิมสีใหไดดั่งใจขึ้นมาอีกนิดครับ  

 
 
ขอตอทายบทนิดนึงนะ สวนใหญแลวตอนเวลาผมทํางาน ผมมักจะขยายรูปใหดูใญอยูเสมอๆ ดวยเหตุผลท่ีวา 
รายละเอียดบางแหงอาจซอนอยู และผมกอมักจะยอรูปใหเลกลงเสมอๆเพ่ือท่ีจะดูน้ําหนักแสงเงาครับ  

 
 
ตออีกนิดรูปสีเกายากกวารูปขาวดําแนๆเลยเนาะ(ผมวาง้ันแหละ) 
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7. ขาวดําเปนสี 
การลงสีใหกับภาพขาวดํานั้นสามรถทําไดหลายวิธี แหละเทคนิคนี้เปนสวนหนึ่งในแนวการลงสีของในแนว
ของผม  
1.เม่ือทานไดเก็บลายละเอียดบางสวนของรูปแลวและไดทําการปรับรูปเปนขาวดําแลวอีกอยางท่ีสําคัญคือทาน
ตองทํางานท่ีสองเลเยอร คือมีฉาก1เลเยอรและมีรูปตัวแบบ1เลเยอรในไฟลงานเดียวกัน 

 
 
2.ใหหทานล็อคselectionเฉพาะผิวเนื้อแลวไปท่ี image>adjusments>variations(หรือดูใน
บทหลักการลงสี1)ทานจะไดรูปดังรูปขางลางนี.้.ผมขออธิบายแคชวงใบหนานะครับ 
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3.รูปนี้ผมปรับ color balanceเพ่ิมความสดขึ้นมานิดหนอยครับแลวผมใชbrushหัวแปรงซอฟท คา
opcity2 flow100ใชสีท่ีอยูในรูป ระบายในสวนท่ีทานเห็นผมจะไมระบายลงในท่ีสีดํายกตัวอยางเชนตา 
คิ้ว หรือในรูจมูก หัวแปรงก็แวแตทานครับอยาใหใหญมากนะครับผม(ทานดูแลวเหมือนผมระบายไปท่ัวหมด
แตจริงๆแลว เพราะการใช เปอรเซนตออนๆนั้นจะดูนุมครับ) 

 
 
4.รูปนี้ผมใชbrushหัวแปรงซอฟท คาopcity2 flow100ใชสีท่ีอยูในรูป ระบายในสวนท่ีทานเห็นผม
จะไมระบายลงในท่ีสีดํายกตัวอยางเชนตา คิ้ว หรือในรูจมูก (เหมือนขอ3เลยแตตางกันตรงสีเนาะ)  
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5..รูปนี้ผมใชbrushหัวแปรงซอฟท คาopcity2 flow100ใชสีท่ีอยูในรูป ระบายในสวนท่ีทานเห็นผม
จะไมระบายลงในท่ีสีดํายกตัวอยางเชนตา คิ้ว หรือในรูจมูก (เหมือนขอ3-4เลยแตตางกันตรงสี)  

 
 
6.รูปนี้ผมใชbrushหัวแปรงซอฟท คาopcity2 flow100ใชสีท่ีอยูในรูป ระบายในสวนท่ีทานเห็นผม
จะไมระบายลงในท่ีสีดํายกตัวอยางเชนตา คิ้ว หรือในรูจมูก (เหมือนขอ3-5เลยแตตางกันตรงสี)  

 
 
7.รูปนี้สวางและสดใสไดนั้นผมใช aoto lavels(ใชไดดีเปนบางรูปครับ ถาใชไมไดในรูปท่ีทานกําลังทํา
อยูทานก็ใชlavelsปรับเอานะครับ) 
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8.รูปนี้ผมไปท่ีselect>color range(ดูท่ีบทความเรื่อง การจับจุดแสง) ผมใชท้ัง lavelsและcolor 
balanceปรับลดแสงและเพ่ิมสีใหดูสดใสครับผม..สังเกตุวาสีสันท่ีผมระบายลงไปนอยๆนั้นไดแทรกขึ้มาดวย 

 
 
9.รูปนี้อีกหนึ่งทางเลือกของรูปท่ี9ครับทานสมารถกดctrl+cจะไดการกอปปแลวกดctrl+vจะไดการวาง
ในท่ีเดิมและไดเลเยอรใหม การทําเชนนี้ทานจะไดเห็นสีสันและแสงเงาของการปรับlavelsและcolor 
balanceท่ีชัดเจนขึ้น 
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10.จุดนี้เปนจุดสําคัญของการเครียรพ้ืนผิวครับ รูปทุกรูปท่ีเปนรูปเกานั้นจะมีรอยตะปุมตะปาเต็มไปหมดบาง
รูปก็ไมไชผิวเนื้อหนาจริงบางรูปก็ไชหรือแมกระท่ังสีท่ีเราระบายไปท่ีไมเรียบรอย ส่ิงสําคัญทานควรใช 
healing brushจิ้มตรงพ้ืนผิวในรูปแลวเอามาแทนท่ีนั้นจะดีท่ีหนึ่งเลยแหละ  

 
 
11.ขยายใหทานดูชัดหนอยเนาะ ในสวนของตาและคิ้วนั้นผมใชสีฟาออนระบายนะครับ แลวผิวหนาเรียบ
ขึ้นมาบางนั้นผมก็ใช clone stemp ดวยคับ(ดูในบทอีกหนึ่งวิธีท่ีทําใหผิวเนียน)  
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12.รูปนี้ยอเล็กลงใหทานดูความแตกตางสีตรงใบหนาท่ีผมทําใหทานด ูกับท่ีตรงแขนท่ีผมไมไดลงสีเลย  

 
 
ครับผม สุดทายก็ไดสรุปในบทเรื่องการลงสีไปอีกหนึ่งขั้นตอนเนาะ ผมมีหลายวิธีครับแตจะเขาใจยากหนอย
สําหรับทานท่ีไมไดเคยวาดภาพเหมือนมานะ สวนในเรื่องการลบขอบใหนุมนวลก็เอาไวจะมาสาธิตใหทานดู
นบทตอๆไปเนาะการลงสีวิธีนี้นะคับ จะชวยใหบดบังพ้ืนผิวท่ีไมเรียบไดอีกดวยนะ แลวก็เช่ือมตอของแสงแลว
ก็เงาไดดีครับ..รูปนี้ผมทําใหมเลยนะคับทานไมไดบันทึกการทํางานไวท่ีรูปผมท่ีเอาลงในเว็บบอรดนะ รูปนั้นเพ
นทสดเลยคับงานเรงเลยตองกลาหนอย 
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8. ลบภาพสวนท่ีไมตองการ 
เปนวิธีหนึ่งท่ีผมชอบใชครับสําหรับลบบุคลหรือส่ิงของออกเพ่ือทําใหภาพไดตามความตองการ ก็ไมยากเกินนะ
ครับ ใชคําส่ังและอุปกรณพ้ืนฐานสําหรับคอตกแตงภาพก็รูจักด ีกับอุปกรณ Stamp tool นั้นเองท้ังนี้ก็จะ
ใชรวมกับหัว Brush ขนาดลักษณะตางๆ ดวย เอาหละลุยกันเลย ..  
ภาพท่ีผมนํามาเปนแบบสาธิตใหทานชมครับ 

 
 
 
เริ่มแรกผมใชpolygonal lassoใชคา feather ท่ี5-6ครับ คลิกลากใหครบตามท่ีตองการ เสร็จแลวผม
ไดใช bush รูปนี้ผมใช opacity 80 flow 100ครับผมจุมสีบริเวณไกลเคียงแลวระบายในสวนท่ี เห็น
แลววาฉากหลังนั้นนาจะเปนแบบนั้นผมดูโทนสีเปนหลักครับ  
 

 
 
 
เม่ือผมลบ selection ออกแลวยังคงมีรอยบางอยูนิดหนอย ผมก็ทําเหมือวิธีท่ีผานมานั้นแหละครับ  
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ในสวนนี้ผมได ใช bush ระบายเสร็จตามท่ีผมตองการแลวครับ 

 
 
 
ผมใช heling bush กดคีย alt คลิกจุมพ้ืนผิวบริเวณท่ีตองการนําเอาไปใชครับแลวผมคลิกลากลงบริเวณท่ี
ตองการ ในสวนอ่ืนๆก็ทําลักษณะเดียวกันท้ังรูปเลย 

 
 
ผลท่ีไดก็ออกมาแบบนี้แหละครับ 
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จากรูปท่ีทานเห็นนี้ผมไดลบบุคลขางขวาออก แลวผมก็จัดวางรูปใหสมดุลยพอดีกับท่ีผมอยากไดขนาดตามท่ี
ตองการครับ สังเกตุไดวารูปนี้เม่ือเอารูปบุคลขางซายออกแลว ปลานั้ตัวใหญขึ้นเยอะเลยเนาะ  
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9. หลักการลงสีผิว 1  
ครับในขั้นตอนนี้ผมอยากจะนําหลักการลงสีแบบมาตรฐาน 

ท่ีใชกันทัวไป ลองมาชมกันครับ 
ผมจะใชรูปท่ีผานขั้นตอนการใชเครื่องมือตางๆในโปรแกรม photoshop  

มาพอสมควรแลวครับ 
 

 
 

ผมใชเครื่องมือ polygonal lassoใชคา feather ท่ี5-6ครับ ล็อคเฉพาะตรงผิวเนื้อหากทานตองการนํา  
selection มาใชอีกทานก็บันทึกไวท่ี select>save selection ทานก็บันทึกช่ือตามแลวแตชอบเลย

ครับ 
หากทานตองการนําขึ้นมาใช ทานก็ไปท่ี  

select>load selection เลือก select ตัวท่ีทานตองการไดเลยครับ  
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ตอมาผมใชปรับสี โดยไปท่ี adjusments>variations ผมเลือกคาสีในชอง more red ครับ 
 

 
 

คลิกครั้งเดียวครับจะไดสีผิวท่ีไมสดมากนัก เพราะเราสามรถเพ่ิมขึ้นไดอีกในกรณีท่ีเรา เซฟ  
แลวเราก็เรียกขึ้นมาใชไดอีกครับ(ในชอง current pick คือคาสีท่ีผมตองการครับ)  
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สีผิวท่ีไดมาจะอยูในประมาณนี้ครับ 

 

 
 

ในสวนของริมฝปากผมใชเครื่องมือ polygonal lassoใชคา feather ท่ี5-6ครับ แตในขั้นตอน 
นี้ผมใช color balanceครับ ทานสามรถเพ่ิมคาสีตามตองการเลยครับ 
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ในสวนของคิ้วผมใชเครื่องมือ polygonal lassoใชคา feather ท่ี5-6ครับ ในขั้นนี้ผมก็ใช color 
balance  

ปรับคาสีออกไปในโทนสีน้ําเงินอมฟาครับ 
 

 

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
สีสันท่ีไดจะไมดูแบงแยกกันจนเกินไป 

 

 
 

ตอมาหากทานอยากใหผิวสดขึ้นทานสามรถเรียก selection ท่ีทานเซฟไว นําขึ้นมาใชแลวปรับคาสีท่ี  
ตามแลวแตทานชอบเลยครับ 
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ในสวนของเสนผมท่ีอยูบริเวณผิวหนา ทานสามรถเดิน แลวปรับคาสีท่ี ใหเปนน้ําเงินอมฟาไดครับ 
 

 
 

สีสันท่ีออกมา เปนไงครับ พอดูสดขึ้นมาหนอย  
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เปนอยางไรบางครับ หลักวิธีแบบงายๆ.... ในการลงสีอีกรูปแบบหนึ่ง คือการใชวิธีเพนทลงบนใบหนาเลยหรือ
วาในสวนสําคัญๆ เอาไวผมจะนําเสอนอตอไปนะครับ 
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10. หลักการฟนฟูรูป 
มีรูปอีกมากมายครับท่ีตนฉบับเลือนลางและมองโครงสรางของรูปแทบไมคอยออก  

ในขั้นตอนนี้ผมขอแนะนําวิธีการฟนรูป หมายถึงรูปท่ีเราไดจากการสแกน หรือจากกลองก็แลวแตนะครับ หาก
รูปท่ีทานไดมามีลักษณะคลายรูปนี้ ทานลองมาดูวิธี คราวๆกันครับ  

 
 

อยางแรกเลยนะ ผมใช levels ปรับแแสงและเงาใหชัดขึ้นมาหนอย แลวผมก็ใช bursh เพนท ผมใช 
opacity 15-20 ครับ ผมจะเพนทโครงกอน  
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ในตอนนี้ผมไดทําการ ตัดรูปมาลงในพ้ืนท่ีท่ีใหม ซ่ึงผมไดเตรียมรอไวแลว ผมไดปรับสีรูปใหเปนขาวดําให
ทานกด ctrl+shif+u=desaturate สังเกตุไดวา การท่ีผมนํามาลงในพ้ืนท่ีใหมนี ้นอกจากจะมอง

เห็นชัดขึ้นแลวยังดูได เปนช้ินเปนอันขึ้นอีกครับรูปท่ีมีคาน้ําหนักท่ีเปนกลางนี ่จะชวยใหเราเพ่ิมแสงและเนน
เงาไดงายขึ้นครับ 
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ในขั้นตอนนี้ผมไดทําการเก็บลายละเอียด โดยเรี่มจาก เนนในสวน ของหู ตา คอ จมูก  

และสวนอ่ืนๆ ผมใช brush เพนทเบาๆ คอยเพ่ิมท่ีละนิด ไปเรื่อยๆครับ จะไมรีบรอน 
และสุดทายกอนท่ีผมจะลงสีผมได ปรับแสงเงา ดวย levels ใหดูมีน้ําหนักขึ้น  
ขั้นตอนนี้อาจจะยากซักหนอยสําหรับทานท่ีไมมีความรู ทางดานวาดภาพนะครับ 

ทําบอยๆ ครับ นี่ก็เหมือนการเรียนรูวาดภาพเหมือนกันครับ 
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ในหลักวิธีการลงสีนี ้ผมจะนําบทความท่ีเตรียมไวทยอยๆมาครับ 
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11. ทําหนาใสก๊ิก 
ครับเปนงานท่ีทําตามความตองการของลูกคาครับผม และผมอยากใหทานดูความเปล่ียนแปลงแตละจุดครับ 
ตนแบบท่ีมาเปนแบบนี้ครับอยากใหทานลองพิจารณาดูวาความเปล่ียนแปลงท่ีเกิดขึ้นนั้นแตกตางกันพอสมควร 
แตก็ยังคงมีความเหมือนตัวแบบอยูซัก60-70เปอรเซนตครับ  

 
 
 
แตละอยางของความใสใจในการทํางาน ผมจะคิดถึงเสมอวา ทําไงก็ไดแตตองมีความเหมือนหลงเหลืออยูครับ 
อยางเชนโครงหนานั้น ผมทําตามความตองการของลูกคาครับ 
ในสวนอ่ืนๆนั้นผม ทําตามใจตัวเองครับไมวาจะเปนตา คิ้ว ปาก ผมใชประสปการณ ท่ีวาดรูปมา20ป บรรเลง
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ลงไปครับ ตรงไหนควรเนน ตรงไหนควร เอาออก นี่แหละครับจุดสําครับคับผม 

 
 
รูปบางรูปท่ีเสียหากเรามองผานๆไปแลวก็คิดวาไมนาแตงไดอยางตัวอยางรูปนี้ผมเองก็เกือบจะไมรับอยู
เหมือนกัน แตพอเอากลองมาสองดู(เพราะเปนรูปเล็ก)ก็พอทําไดครับ  
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12. แกไขภาพที่ขาดหาย 
อยางเชนรูปตนแบบรูปนี้ดีตรงท่ีวาเปนรูปหนาตรงถาเปนดานอ่ืนก็คงจะแกยากกวานี้อีกครับ สวนใหญแลวคน
ทุกคนจะมีสัดสวนและตา จมูก ปาก หู 2ขางท่ีคลายกันครับ จะมีกอแตทรงผม ท่ีหวีไปอีกทิศทางนึง ในสวน
ของช้ันตาก็จะมีช้ันตาบน2ขางไมเทากันบาง แตในสถานภาพแบบนี้คงตองใหลูกคาหรือคนไกลชิดกับรูปท่ี

เสียหายแบบนี้มาดูกอนท่ีเราจะปริ้นกอนก็ดีทีเดียวเลยละ 

 
 
 

เริ่มตนดวยผมไดเก็บรายละเอียดไดพอสมควรในดานหนี่งแลวก็ชpolygonal lasso tool คลิกใหครบ
ในสวนท่ีตองการนําไปใชนะครับแลวทําการกอปปโดยกดctrl+c 
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ในรูปดานซายมือนั้นผมไดทําการกอปปออกมาแลวสรางพ้ืนท่ีทํางานใหมโดยการกดctrl+nแลวผมนํารูปท่ีทํา
การกอปปออกมาวางโดยการกดctrl+v...ในสวนรูปดานขวามือนั้นผมไดทําการปรับรูปใหหันมาอีกดานนึง

โดยไปท่ี 
image>Rotate Canvas>Flip Canvas Horizontal  

 
 
 

แลวทําการเคล่ือนยายมาท่ีรูปตนแบบอีกครั้งหนึ่ง ท่ีพาเลตเลเยอรจะมีเลเยอรใหมเพ่ิมอีก1เลเยอรครับ  

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
 
 

ในขั้นตอนนี้ผมไไดปรับOpacityประมาณ50%ท่ีเลเยอร1ใหจางลงเพ่ือท่ีจะดูความแตกตางของรูป
ตนแบบท่ีเสียหายและปรับโครงสรางใหดูไกลเคียงความเปนจริงมากท่ีสุดครับ 

 
 
 

ในรูปขั้นตอนนีผ้มไดใชยางลบๆบางสวนท่ีคิดวาไมจําเปนออกไปโดยผมลบท่ีเลเยอร1นะครับและไดทําการ
บีบโครงสรางของเลเยอร1ผมใชCrop tool ครับ  
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แลวผมก็เริ่มเก็บรายละเอียดอีกครั้งหนึ่งครับโดยผมใชเครื่องมือตางๆในบทความท่ีนําเสนอไปบางแลวนั้น 

 
 
 

ผลงานรูปนี้ไดสงลูกคาไปก็เปนท่ีพอใจพอสมควรทําไดเทาท่ีทําไดเนาะ ก็ยังดีปลอยไวในสภาพแบบนั้นจริง
ไหมครับ 
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หากทานมีขอสงสัยหรือตรงไหนท่ีผมอธิบายแลวทานไมเขาใจ ทานก็คอมเมนทในหนานี้ไดเลยนะครับ 
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13. เปลี่ยนฉากหลัง 
การใชคําส่ังExtractลบฉากหลังและเคล่ือนยายรูปผมนํามารวมไวในบทเดียวกันเลย มี
ทานนึงลงขอในกระดานขาวสองรอบแลวลาสุดอยากใหผมนํามาแนะลงในเว็บเลยเพ่ือความ
เขาใจไดงายขึ้นแลวไดเห็นภาพ 
 

ใหทานเปดพ้ืนท่ีทํางานใหมรอไวครับ เทสีหรือหรือระบายสีตามท่ีตองการนะ ขนาดนั้นใหใชขนาด
เทาไหรกอไดตามท่ีทานตองการเลยครับ  

 
 
 
เปดรูปท่ีตองการออกมาเตรียมไวรูปท่ีจะไชกอตองเล็กกวาพ้ืนท่ีๆทําประมาณ2ใน4หรือ1ใน4แหละครับ 

 
 
 
ใหทานเลือกรูปแลวไปท่ีเมนูบารคลิกท่ีimage size ปรับแตงขนาดรูปดูนะครับ  
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ท่ีเมนูบารใหทานเลือกExtractเพ่ือเปดการทํางานลบฉากหลัง 

 
 
 
หมายเลข1คือใชระบายสีขอบตัวบุคลในภาพ ระบายใหชิดหนอยนะครับวนใหรอบรูปเลยแตถามาประจบกันท่ี
ขอบแบบในรูปนั้นก็ไดครับแตถาไมถึงขอบก็ตองใหปปลายของสีเขียวท้ังสองดานมาประจบกันนะ ในสวน
ของการระบายหากไมไดดั่งใจแลวทานสามารถใชยางลบๆแตงไดครับ 
2.เม่ือทานระบายเสร็จแลวใหใชถังสีเทสีลงไปในตัวบุคลดังในรูป(ผมใชสีฟาครับ)ถึงเวลานี้หากทานพอใจก็คิก
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OKไดเลยครับ แลวทานจะกลับไปสูหนาตางของโปรแกรมPhotoshop 
3.ยางลบ 
4.ไวไชเลือกสีท่ีมีหลากสีนะครับ 
5.เม่ือทานคลิกPreviewใชเก็บลายละเอียด 
6. เม่ือทานคลิกPreviewตัวนี้สามารถทําใหขอบคมชัดไดดีครับ 
7.เอาไวขยายรูปนะ 
8.ไวขยับเยื้อนรูปครับ 
9.ปรับปรายหัวภูกัน 
10.เลือกสีใชระบาย 
11.เลือกสีไวสําหรับเท 
12.ทานตองการความนุมแคไหนก็เลือกตรงนี้แหละครับเลือกกอนท่ีจะระบายขอบนะครับ 
..เม่ือทุกอยางเสร็จส้ินแลวใหทานคลิกOkไดเลยครับ 

 
 
 
ภาพนี้แสดงถึงการท่ีเราไมลากระบายสีใหชนขอบ เราตองเอาหัวทายมาประจบกัน  
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เม่ือทานกลับสูหนาตางปกติทานก็สามรถตบแตงไดอีกนะครับโดยใชยางลบๆอีกก็ไดหากยังไมพอใจนะ 

 
 
 
ตอไปนี้เราจะมาเคล่ือนยายรูปกันครับ ใหทานเลือกเครื่องมือ Move toolตัวนี้ท่ีกลองเครื่องมือคลิกรูป
ท่ีรูปดานบนคางไวแลวลากมาท่ีพ้ืนท่ีทํางานท่ีเราเตรียมไวดังรูปขางลางนี้ครับ 
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ท่ีออปช่ันบาร ใหทานทําตามรูปนี้นะผลท่ีไดจะปรากฎดังรูป
ขางลางนี้แหละครับเม่ือทานคลิกจิ้มท่ีรูปใดดวยเครื่องมือMove Tool ทานสามารถคลิกคางแลวลากขยับ
เขยื้อนไดนะครับ หากทานตองการท่ีจะยอหรือขยายรูปแตละตัวบุคลใหทานกดShiftท่ีแปนคียบอรดคางไว
แลวก็คลิกมุมใดมุมหนึ่ง หากทานไปคลิกดานขางนั้นรูปท่ีออกมาจะเพ้ียนสิ ลองดูครับไมลองกอไมรูเนาะ  

 
 
 
ในบทนี้ผมทําใหดูสองรูปนะท่ีเลเยอรจะมีแคเนี้ย แตท่ีทานบอกมาจะทําหลายๆรูปก็ใชวิธีเดียวกันหมดแหละ
ครับจะกี่รูปนะ หากทานอยากใหรูปคนไหนอยูหนาหลัง เชน หากตองการใหรูปสาวนอยคนขางหนาไปอยูขาง
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หลัง...ในชวงตอนแรกท่ีทานจะนํารูปมานั้นทานคลิกท่ีฉากหลังดวยMove toolแลวทานไปคลิกลากรูปมา
รูปนั้นกอจะอยูดานหลังของรูปม่ีนํามากอนแลวสิครับ  

 

 
 
สุดทายทายสุดก็อยาลืมรวมเลเยอรดวยนะครับ คลิกลูกศรตรงมุมขวาบนท่ีพาเล็ตเลเยอรนะครับเลือก Flatten 
Image นะ หรือจะใชMerge Visible ก็ไดครับ 
masterkae 
 
..พอดีมีคําถามเขามาทางเมลผมเลยเอามาลงในบทนี้กันเลยนะครับ  
..สมาชิกทานนึงถามมาวาหากตองการจัดรูปท่ีรูปแตละรูปละไฟลมีขนาดไมเทากันแลวนํามาเรียงในพ้ืนท่ีใหม
(ขนาดใหญ)ควรจัดอยางไร ผมขอแนะนําวา หากตองการใหรูปแตละรูปมีขนาดเทากันนั้น ตองใชเครื่องมือ 
Crop Tool โดยในสวนของออปช่ันบารนั้นใหทานปรับคา ของขนาดแลวความละเอียด ดังในตัวอยางผม
ไดตั้งคาไวเพ่ือท่ีจะทําการตัดรูปขนาด8x10นิ้วครับ โดยผมใชคาความละเอียดท่ี300dpiครับผม แลวนํามา
คลิกลากบนรูปท่ีเราตองการตัดแลวดับเบ้ิลคลิกหรือกดEnterครับ แตขอเสียในการทํางานเรียงรูปแนวนี้เรา
จําเปนตองทําใจเรื่องของรูปท่ีเราตัดนั้นขนาดจะบังคับ บางสวนท่ีเกินขนาดจําเปนตอง(ทําใจ)ครับ^^ 
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14. ทําสีเน้ือใหม 
ผมมีความคิดวาเรานาจะแนะวิธีเรื่องแสงและเงาแบบการเรียนรูถึงรูปรางรูปทรงไปดวยครับ
และนี่เปนวิธีหนึ่งท่ีผมพอจะแนะในขั้นตอนนี ้ผมพอเรียบเรียงแลวเอามาประยุกตใหควบคู
กัน 
 

จากรูปสมาชิกทานหนึ่งซ่ึงมีความพยายามเปนเลิศทําใหผมมีความรูสึกวาตองตอบทใหแตกหนอยหละ นับไดวา
สงมาหลายรูปแลว สงสัยผมตองเพ่ิมพ้ืนท่ีเว็บแระคับทาน(ฮา) รูปนี้อยูในขั้นสุดเกือบสุดทายของความพยายาม
ของทานสมาชิกทานนี้ครับผมวาออกมาดูดีสําหรับ งานช้ินแรกแลวของคุณ sornylee 

 
 
ขั้นตอนแรกนี ้ใหทานล็อคselection ใช featherซัก10-15 ครับ  
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ทานกดท่ีแปนคียบอรดนะ ctrl+c จะเปนการกอปป แลวทานก็กดctrl+vจะเปนการวาง ท่ีพาเล็ตเลเยอร 
ทานจะไดเลเยอรใหมครับเราจะทํางานกันบนเลเยอรใหมนี่แหละคับผม 

 
 
 
ใหทานมาท่ีfilter>noise>madianครับปรับคาเฉล่ียแลวใหดูเปนแบบของผมแหละคับ 
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ผมเห็นรูปนี้ทําใหผมรูสึกวาผมกําลังจะวาดรูปจริงเลยคับเนี่ย เปนการคลุมโทนสีและหาน้ําหนักแสงและเงา
กอนท่ีผมจะเอาสีไประบายตามตา จมูก ปาก นะคับ มาดูกันตอคับผมเม่ือผลท่ีออกมาจากการใชฟลเตอร 
median 

 
 
 
รูปตอมานี้ผมไปท่ีพาเล็ตเลเยอรอีกครั้งครับ ใหทานปรับopacity ประมาณนั้นแหละครับ  

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


 
 
 
รูปท่ีไดออกมาเปนเชนนี้ครับผม ประมาณวาผมจะจัดแสงเงาตรงใบหนานี้ใหมครับ 

 
 
 
รูปขางลางนี้ตรงท่ีผมล็อคselectionไวนั้นผมจะใชยางลบๆออกครับแตทานไมจําเปนตองล็อกselection
ก็ไดครับผมทําใหดูชัดๆนะ ใชหัวแปรงซอฟทนะครับนุมดี opacity20-30%flow100 คอยๆลบย้ําไป
ย้ํามานะครับ ถาใชทีเดียว100%ผลท่ีไดจะดูแข็งครับแลวจะเปนหลุมเลยหละ 
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รูปนี้เปนผลท่ีไดมาครับเปรียบไดวาไดกระจายแสงและเงาใหนุมขึ้นมาใหมแลวเปนอีกหนึ่งทางเลือกครับ 

 
 
 
รูปปนี้ผมไดรวมเลเยอรแลวเก็บลายละเอียดไปบางนิดหนอยครับโดยการใชเครื่องมือ brushเก็บบริเวณตา
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จมูกปาก และ colne stampเก็บตามแสงและเงา ผมใชเปอรเซนตออนคับ ทําแบบในบทความท่ีผานมา
แหละ 

 
 
ท้ังหมดนี้ผมใชโครงสรางเดิมของทานสมาชิกsornyleeท้ังหมดครับเพียงแตผมเพ่ิมลายละเอียดน้ําหนักตาม
ลายละเอียดอยางเชนปากครับเพราะสมาชิกทานนี้ดานการวาดภาพเหมือนนั้นทานไมไดฝกมาแตทานทํางาน
ออกมาไดระดับนี้ถือวาใชไดแลวหละ อีกหลายทุกทวงทาขึ้นอยูกับทานดวยครับวาเห็นสมควรเพ่ิมลดในสวน
ใหนนั่นแหละครับคือตัวทานบางทีผมชอบเขม ทานชอบหวานขึ้นอยูกับสไตลงานของตัวเองดวยครับผมอยาง
แนๆเลยนะครับความเปนจริงตัวอยางเชนใบหนาเปนสวนสําคัญอยางมากทานควรศึกษาจากรูปถายท่ีชัดเจนไป
ดวยครับลองเอามาเปรียบเทียบกัน รูปท่ีผมใหไปนั้นคงยากซักหนอย ในดานแสงเงารูปตนแบบนั้นจะเพ้ียน
พอสมควร ผมหวังวาคงเปนประโยชนเนาะ 
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15. ทําภาพใหเปนการตูน 
ครือจะใชPsทํารูปออกมาเปนการตูนแนวหวานแหววคลายๆ illusจะเผยวิธีการใหด ูอันใหนมีประโยชนก็
ลองไปทําดู อันใหนหวยก็อยาทําตามนะครับ อธิบายเปนครั้งแรกไมใชคนเกงเพ่ิงจะเปนมือใหมหัดซนครับ 
สวนมากไดเทคนิคมาจากอาจายแกะแหงไทยรีทัสวิทยานี่แหละครับ มาม่ัวตามกระผมไดเลยแตนแตน 
1.เปดรูปท่ีตองการจะสรางขึ้นมา แลวสรางlayerใหมขึ้นมา แลวเทสีขาวลงไป 
ตั้งOpacity 100% 

 
 
2.แลวปรับลดคาOpacityท่ีlayer1 ใหเปน50% 

 
 
3.แลวเลือกสีน้ําตาลเขมหนอย ใชPaintBrush Tool เลือกเล็กท่ีสุด 1 Pixels เสียเปรียบโปรแกรม
อ่ืนก็ตรงความละเอียดนี้แหละ แลวก็กอป ป เสนตามสวนหนาคิ้วปากคอจมูกแขนนิ้วคือสวนท่ีเปนผิวเนื้อ
ท้ังหมด (ตองใหเสนบรรจบกันไมง้ันเวลาเทสีจะเลอะออกไปนอกรูป) ลุยเลยครับ โยว..... 
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4.แลวปรับคาOpacity ท่ี Laler1 ใหกลับมาเปน 100%(ตรงท่ีวงสีแดง) 

 
 
5. เลือกสีน้ําตาลไวหยอดสีผิว ปรับคาOpacityของสีซัก20% หรือเทาไรก็ไดตามใจไมวากันครับ ผม
เลือก20% ถาออนไปก็เททับลงไปไดอีกไมเสียตังค 
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6.จากนั้นก็หาทางตัดลูกตากับปากออกมา ผมใชLasso Tool มะเปง จึงใช Edit Quick Mask 
Mode แทน ตรงท่ีวงสีแดงไวมุมซายลางอะคับ แลวเลือกปากการะบายสวนท่ีตองการจะตัดไวใชงาน  

 
 
7. เม่ือระบายเสร็จก็กดEdit Standdard Mode ปุมถัดไปทางซายมือ(วงสีแดง)แลวเลือกSelect 
>Inverse จัดการลากลูกตากับปากจากตนแบบมาวางไวในงานใหตรงกันนะครับหนาตาจะไดไมผิด สัด 
สวน  
จุดงานตรงนี้สําหรับผูมีฝมือในการวาดก็เชิญวาดไดเลย กระโผมเคยลองวาดเองแลวผลท่ีออกมาหนาตา กลาย
เปนฮิปโป(ไมรุง)เลยใชวิธีโกงแบบนี้อิๆๆๆๆๆๆๆ 
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8. ปากกับลูกนัยตาก็จะเปนLayer2 จะลบสวนท่ีเกินหรือจะปรับแสง-สี หรือจะซนอะไรในสวนของปาก
และตาก็ซนไดเลย ลุยยยย.... 

 
 
9. ตอนลบนี่ใจเย็นๆนาคับ ภาพจะสวยหรือไมนั้น ปากกับลูกนัยตานี่ก็สําคัญเหมือนกัน ใจเยนเยน..................
แลวปรับแสงสีตามท่ีชอบไดเลย 
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10. ถึงเวลาของการทําทรงผมแลวอิคราวนี ้ก็ใชวิธีเดียวกันกับปากและลูกตา(ไมใชลูกยายนะครับ) 

 
 
11. สีสันของเสนผมก็ไปปรับสีสันใหแจว+แหววใน Image > Adjust > Variation ตองการสี
ยังงัยก็เลนไดเลย สวนเส้ือเกาะอกของหลอนลายเส้ือทํายากก็ตัดดึงมาใสใหเธอโดยวิธีโกงแบบเดิมๆ ถาวางมาก
ก็ระบายสีเองหรือใสสีก็ได 
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12.สุดทายและทายสุดก็คือเก็บลายละเอียดแสงเงาตรงใบหนา อันนี้สไตรใครสไตรมานนาคับ ผมก็ยังเหยอยู
เหมือนกันรออาจารยแกวางจากการจีบเดะกอนคอยมาสอน รอคอยกันหนอยนะครับพวกเราในของสวนแสงเงา
วิธีการไลแสงเงาใบหนาผมใชตั้งคาpacityของPaintBrushท่ีต่ําสุดคอยๆไลไปเรื่อยๆตามแกม....แลวก็...
ซอกคอ...เปลือกตาทุกสวน ฮั่นแนๆแหม...เคล้ิมตามเลยใชปะ วิธีการก็มีแคนี้แหละครับสวนการสรางปอยผม 
หรือชอผม สําหรับเอามาเปนPattern กะลังลองพยายามหัดทําอยู หรือทานใดมีไอเดียรบรรเจิดชวยแนะนํา
ดวยนะครับ 
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16. ทําพ้ืนผิวใหกับเน้ือ 
ในบทนี้ผมไครขอแนะนําการลงพ้ืนผิวใหกับเนื้อบนใบหนาในสไตลของผม มีหลายวิธีครับท่ีเราสามารถใสผิว
ใหมใหกับผลงานท่ีเราจําเปนตองสรางผิวเนื้อขึ้นมาใหม ยิ่งเปนภาพท่ีเสียหายเยอะๆแลวละก็เราจําเปนตองใช
brushระบายลงไปแลว จะเกิดความเนียน ถาหากเราจะปลอยไวแบบนั้นก็ดูยังไงๆอยู 
1.ในรูปขางลางนี้ผมไดทําขึ้นมาเองครับ ใหทานลองเอาไปใสบนพ้ินผิวกันดูครับ(เซฟไดเลยครับผม)  

 
 
 
2.เม่ือทานนําลงไปไวในเครื่องของทานแลวใหอัฟไฟลขึ้นมาใหมในคาResolution300ครับ แตก็ไมได
หมายความวาจะตองเทาผมนะครับ จะขึ้นอยูกับไฟลงานท่ีทานกําลังทําอยูดวยขึ้นอยูกับทานดวยครับวาจะใช
ขนาดเทาไหรๆท่ีใหไดเหมาะสมกันกับเม็ดผิวท่ีทานตองการนะครับ ส่ิงสําคัญอยางยิ่งเลยคือทานตองแปลงไฟล
เปนนามสกุล .PSD  
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3.ในสวนของขั้นตอนนี้ผมจะขอแนะนําสวนของใบหนาดีกวาเนาะจะไดไมยุงยากจนเกินไปในรูปขางลางนี้ผม
กดCtrl+J ท่ีแปนคียบอรด จะไดเลเยอร1ครับ แลวผมล็อคSelectionใชคาFeather10%ครับ 

 
 
 
4.ผมไปท่ีFilter>Texture>Texturizerจะไดหนาตางดังขางลางเนี้ยแหละ แลวคลิกตรงลูกศรใน
วงกลมสีแดง แลวเลือกLoad Textureครับ แลวผมก็เขาไปหาไฟลท่ีเก็บรูปพ้ืนผิว(ตองเปนนามสกุล.
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PSDเทานั้นนะครับ(ย้ําๆ)เม่ือทานหาเจอแลวก็คลิกไฟลพ้ืนผิวไดเลยครับ ในสวนของScalingกับRelief
ทานลองปรับเลนดูแลวกันเนาะ ชอบแบบไหนก็ปรับเอาตามใจชอบกันเลยครับผม  

 
 
 
5.ผลท่ีไดออกมาก็เปนดั่งเชนรูปขางลางนี้แหละครับ 
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6.เหตุท่ีตองมีสองเลเยอรก็เพ่ือความสะดวกไงครับเราสามารถใชยางลบๆในสวนท่ีเราไมตองการท้ิงออกไป แต
มีขอสําคัญอยูวา ทานควรจะใชOpacityในเปอรเซนตออนๆนะครับจะไดคอยๆจางๆหายไป ในวงกลมนั้น
ผมแสดงใหเห็นวาชวงตรงปากนั้นจะไมมีเม็ดพ้ืนผิวแนวท่ีกําลังใชอยูนี้เลยครับ ใหทานปรับหัวแปรงไดตามใจ
ตองการเลยครับ 
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7.เม่ือในจุดท่ีเม็ดผิวท่ีใสลงไปนั้นไมไดสมดุลยดั่งใจเทาไหรทานก็ใชHealing brushจุมตรงบริเวณท่ี
ตองการดังหมายเลข1แลวไปคลิกลงตรงตามพ้ืนผิวท่ีตองการเปล่ียนดังหมายเลบ2ครับ 
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8.หากทานทําไปไดสักระยะแลวเกิดความไมพอใจในเม็ดผิวท่ีมากเกินไปหรือวาโดดจนเกินไปทานก็ไปปรับท่ี
พาเล็ตเลเยอรใชคาOpacityท่ีลดลงมาไงครับ 

 
 
 
9.ในรปูขางลางนี้ผมแสดงการใชSmudge Toolถูใหไปตามทิศทางของริ้วรอยธรรมชาติของผิวเนื้อครับ 
โดยใชเปอรเซนตตามความเหมาะสมครับสวนใหญแลวก็จะไมเกิน50%ของStrengthครับ 
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10.แสดงการปรับใหคมชัดครับ 
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..สุดทายในบทนี้ครับ พ้ืนผิวตางๆท่ีทานสนใจจะนํามาประยุคตใชทานก็นําขั้นตอนในบทนี้ลองพลิกแพงเลน
กันดูครับ ไมวาทานจะสรางขึ้นมาเองหรือวาเอาพ้ืนผิวเนื้อจริงๆมาใสก็ทําไดเชนกันครับ อาจจะสลับสับซอน
หนอยจริงๆแลวผมก็อยากท่ีจะนํามาใชผมกันนะครับ แตคอนขางจะเขาใจยากสักนิด มีหลายวิธีครับท่ีนําพ้ืนผิว
มาลงในสไตลของเราโดยไมตองใชในฟลเตอรของPs < 
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